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Creating a visualization scenario

Steps :

|dentify the satellite’s geometric model
|dentify the satellite’s position and attitude ephemeris
Select the visualization tools

Define the solar generator kinematics

1111l

Simulate a radio signal emission
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Installing & Launching the tool

No installation required — Portable tool

Preparing the tool: unzip the archive into a folder

Launching the tool: Double click on “startVTS.exe”

AR 2 g
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| » Bibliothéques » Documents » Software b Vis-WindowsMT-32bits-2.7 »

. Fichier Edition Affichage Outils ?

Organiser » Quvrir Partager avec ¥ Courrier électronique Graver Nouveau dossier =~ Al @

| Vis-WindowsNT-32bits-27  +

I Apps
L 2dwin
| Broker
1. Catalog

b ) Celestia
|/ Converter
1! InfoBox
A Libs
R

| Data
|, CubeSat

1 ExempleCIC
. Plancton
1. Rosetta

1l smos

| Generators

1 KeplerianGenerator
L TLE2CCSDS

Bibliothéque Documents
Vis-WindowsNT-32bits-2.7

Nom Modifié le Type Taille

L Apps & Temsiocg V13 17 = . = T Fa—
Al . o

J) Data o

| Generators

= | Changelog.tt
% CIC-Exchange-Protocel-V2.0.pdf
| @ startVTS.exe
T VTS-User-Manual-2.7 pdf

/
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Creating a new project

% Timeloop VTS 2.7

File Project Help

1. Creating the “UniverSat” project wmmp CiSB[ > - .

» Menu “New Project”

- Select the folder “Data/Exemple CIC”
- Create the "UniverSat” project

#& Create a new Project

Thew project [Fraio EAor

Element MName

2 |

@@v‘ Ji « Data » ExempleCIC »

~ [ #3| [ Rechercher dans : Eremptecic P

| Organiser v Nouveau dossier = - @
£
T Fxvore * Nom Modifié le Type
B Bureau .. Data 17/11/201512:55 Dossier de fichiers
. Emplacements ré u Models 17/11/2015 12:55 Dossier de fichiers

Date Element

& Téléchargements = || ExempleCIC_1ats 21/07/2014 16:13 Fichier VTS
. | FremnleCTC 2ate 31/07/2014 16313 Fichier VTS
% Uni (DUl halp/D WindowsNT-32bits-2.7/Data/ExempleCiC) - Timeloop VTS 2.7 e 5
File Project | Help |
HHOCNE®IDC €cnes
Structure | Scenario Editor | EventType Editor
Element Name Time Configuration - Standalone E
4 Project =
{© Time& Options Computedates| ] Auto compute
4 @ Celestial Bodies Start date:
» @ Body Earth
& satelites 01950 ;| 24179.3886043981
4 Appleations MD ;| 57461 [ 33575.420000 |
€ Celestia %0 - Celestia & s ———— |
| 150 ;| 2016.03.14 |
Project : 0.0005
|
| End date :
| i
| 01950 ¢ 24179,43027106%8 ] =1
MID 1[ 57461 37175.420000 | E
150;. chliiie Safesay |
Project : | 3500.000 s
[] Synchronize with system time
Start Options I
@ Initial tme ratio:  1.00000 :j () Use scenario state tme ratio
[7] Pause visualization
[7] Loop visuslization
[7] Minimize broker
[] Auto close at end date
Date Element Message
10:19:35 Writer Project saved in Dy/Utilisateurs/rochalp/Documents/Software/Vts-WindowsNT-32bits-2.7/Data/ExempleCIC/UniverSat.vts

The “project folder” is the root folder that contains the project file (.vts).
To avoid portability issues, all data files (CIC files, 3D models, textures) should be in sub folders inside the project folder.
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Adding a satellite to the visualization scenario (1/2)

2. Adding a satellite =
S —

1. Right click on the group & Sateliites - okt

@ Time & Options Satelite Name :  UniverSat

2. Click on “Add satellite” on the menu o ® e erctno: (gl =

» @ Body Earth

3. Rename it “UniverSat” R [P p—

2D Properties [ Link with a color file
3D Properties r
| | Browse... 3 |
Position/Orientation -
4 @ Applications
P : Solcl
€ Celestia 20 - Celestia GRS e
Pen width ; 2 [

3. Defining the satellite’s geometrical model BET IO INCY beres

Structure | Scenario Editor | EventType Editor |

Element Name Model

1. Click on “3D properties” "7 o S -
] N " 4 Celestial Bodies 3dsFile: Models/CIC_Sat_PR.3ds -_BIOWSE--- Tl
2. Select the file “Models/CIC_Sat_PF.3ds e

a G Satellites

3. Change the units to mm ‘W o ok onere v ]

‘ 2D Properties Center of gravity

20 Broperies Coardinates in satelite frame : X = 0 m¥=0 mzZ=0 m.
Position/Orientation
@ Applications Reference sxes
€ Celestia #0 - Celestia

Display axes at : @ Model frame arigin () Center of gravity

iy,
dl:.l‘nljII
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Adding a satellite to the visualization

scenario (2/2)

BEHIO@EEEDC
Structure | Scenario Editor | Event Type Editor
4. Defining the satellite’s position/orientation T e
1. Click on Position/Orientation DA T ﬁ e =
2. Select the “File” tab option for the “Position” e T
3. Select the file “Data/CIC-Sat_ POSITION_ VELOCITY. TXT” ) D
4. Select the “File” tab option for the “Orientation/Quaternion” T s || ORI D
5. Select the file “Data/CIC-Sat. QUATERNION.TXT” | = constant | < e | o seam
@ CICfle: Data/CIC-5at_QUATERMICN, bt

5. Calculating the files time range
1.

v@|iBEY DE

ile  Proje
28

Stuiase | scenario Editor | Event Type Editor |
Element Name || Time configuration - Standalone
Project
@ Time & Options [7] Auto compute
4 @ Celestial Bodies Start date :
@ Body Earth

v)
2. Click on the button ©Compute dates.
4 @ Satellites D1950 : 24296
4 ¥ Satellite UniverSat
£ MID: 57578 0.000000
vents o
2D Properties 150: 2016.07.08 00:00:00 UTC
3D Properties Profect : 0.000s
Position/Orientation
4 @ Applications
€ Celestia 20 - Celestia End date:
JD1950 * 24297 =i
MID: 57579 0.000000 E
150 2016.07.10 00:00:00 UTC
Project : 86400.000 s
7] Synchronize with system time
Start Options
@ Initial time ratio :  1.00000 +| @ Use scenario state time ratio
[T Auto dose at end date

On the project’s tree view click on Project

Ccnes

The Compute Dates button calculates the time intersection ranges for the files used on the project.

6 BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA

PASO



Adding applications for scenario visualization

- ”T:lﬂ ljdp: +E% DC
| Svwtrs | somana Baier_ | Bveni T i
6. Adding the 2dwin tool B T |
> @ Boky cath e ==
1. Rightclick on @ Applications ?“gg:g; o BT | ——
2. Click on “Add Application” — - | e |
3. Select “2dWin” s =

7. Configuration validation

. — . ] ‘.[E' DO|iEE® D E Ccnes
Click on [.Check project S st | i

Information
4 Project =
@ Time & Optiens 2D Win plugin
4 @ Celestial Bodies The 2D Win application is a 2D world map of the central body, using an equirectangular projection (plate carré
b Body Earth projection).
2 @' Satellites Mote ; Currently, if the project contains more than one celestial body, only the first one is shown in the 2D Win
. . . 4 ' Satellite UniverSat application.
8. Saving the configuration
. 2D Properties
3D Properties
. Position/Orientation
- Clickon [+ Save S
- € Celestia #0 - Celestia Start Gptons
[ 2dWin 1 - 2dWin
Launch 2dWin #1 when Broker starts
Initial States
Property name

Value

Once an error is detected by the Check Project (or Run when a visualization is launched) procedure, the error messages

are displayed on the Logger on the lower part of the configuration window. Double clicking the message will open the
configuration panel where the error was found.

//
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Launching a visualization

9. Launching a visualization Fife Project Help

Clickon » Run o
The configuration window will be minimized

The Broker launches
2dWin and Celestia visualization windows are launched

hwnNPE

B #1- 2dWin = B X || B #0- Celestia
I

UniverSat

e
% UniverSatuts (D#Uﬁisﬁmha]pm;@nbfséﬁ»vareNWind NT-22bits-2.7)/Data/ExempleCiC) - Broker - Timeloop VTS 2.7
—— —

-, | 10.07.16 00:00 10.07.16 12:00

UniverSat

A E-) R T &£ ¥ £ | 08.07.161200 i-pg.o;f.laoo:oo 05.07.16 12:00

150 2016.07.09 »= O

position. Change the position of the window on the first plane to view the other.

Celestia and 2dwin window’s position is not yet saved, so both applications will launch with the same size and

BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA
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Visualization (1/4)

10. Window placement

1. Clickon [~ to show the complete Broker’s interface
2. Move and resize Celestia and 2dWin windows
3. Clickon” _gJ Save window positions for current state only”

TE . | 09.07.1g00:00

~ . 09.07.16 12:00 o [

1 CIC-Sat POSITION VELOCITY.TXT A e

2 [CIC 5ot QUATERNION b WY

b4 [ In. | 3

LT SR APeR

Timeline | View Properties I Events I 3D Cameras I Applications I Server |

With VTS it is possible to change the position and size of each window for specific events of
the visualization scenario, giving a better focus of those mission phases.

11. TimeLine Control

Play/Pause Slowdown

Slider Zoom (mouse wheel)

Reverse Speed Up

_ 09.07.16 12:00

W00k faster | ¥ &
150:[ 20160709 | oz:ozosutc | » &

L P ¢
= »
-
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Visualization (2/4)

12. Changing Celestia’'s Cameras

1. Click on the Broker’s tab “3D Cameras”
2. Click on the different cameras to see the options

#0 - Celestia | =

S QWP D
(= 1S0:|  2016.07.09

Target #{ - Celestia
> Earth

4 UniverSat

> Inertial cameras
Sun and Earth cameras

Wiew from Sun

View toward Sun

View from Earth
View toward Earth
S

QSW frame cameras

'S
g
7
g
|
n
8
E]
g
&

FERS==ER §

> TNW frame cameras

> Miscellaneous cameras | @if

LGEEEdE

!T\mel\ne ! View Properties | Events | 30cemeras | Applications ! Server |

Controlling Celestia’s camera with the mouse:
1. Hold the right mouse button to orbit around the selected object ;

3. Use the mouse wheel to zoom in and out.

2. Hold the left mouse button to pan the camera up/down, left/right;

BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA
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Visualization (3/4)

13. Visualization Options
1. Click on the tab “View Properties”

. . “ . . “
2. Activate the option “Sun direction |
(ye“ow arrow on the V|Sua||zat|0n) Lebel : Tritial state Date: )] TmeRatio: 1.00000
Application Property name Value o
#) - Celestia Body scale xl
EME2000 inertial frame axes | | false
#1 - 2dWin Body frame axes [F] false
Planetographic grid [7] false
Terminator [7] false
All POl visibility [@] true
All ROI visibility V] true
UniverSat
Component visibility [¥] true
Satellite scale xi
Orbit path [@] true
Orbit time window 4h total [
EMEZ2000 inertial frame axes [7] false
Q5W local frame axes [ false
TNW local frame axes [7] false

Satellite frame axes
— ..

Body direction
Velocity vector

L @S e e e o]

E\u‘iewPrcperﬁes ! Events 1 3D Cameras [ Applications l Server

14. Stopping the Visualization

- Close the Broker window
or

CI “ th | t . d File Project Help
- ose all the applications windows T .

or

- Click on the * Stop button in the Configurator

- Save all modifications

f
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Click on “Create state”
Select the tab “3D Cameras”
Select* | # | Earth / Inertial”
Click on “

L

NoghkhwhE

Stop the visualization

, Save all states”
Observe how Celestia’s camera changes when the state changes

Visualization (4/4)

#0 - Celestia

$lnivet ..

===

@ QWP D 1000x faste £ % 2 | PADIBI000
[~ IS0  2016.07.09 zonosute |+ @ | w
Target %0 - Celestia
+ Earth (& ]
Fixed in Earth frame | L} ‘
Tnertial |E‘
& E @
||_'ﬁmE||nE View Properticdil 30 Cameras | Applications | Server
12 BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA

[ Unversatuts (Dy/Utisateurs/rochalp/Dacuments/Software/Vis-WindowsNT-326its-27/Data/ExempleClC) - . E=EEYX)

7.16 12:00

Launch the visualization and right click in the Timeline (pink zone)

I #0 - Celestia

UniverSat.vts (Dy/Utili halp/D
b

fVts-Wi \T-32bits-2.7/Data/ExempleCIC) - ... S=i[nl=
1 a

o | @ W P D

[~] 1S0: 2016.07.09

Torget
4 Earth

[
Fixed in Earth frame |
|

Inertial

LG Ed™

9 > 9]

Timeline | View Properties | Events 30 Cameras Applications | Server |

09.07.16 00:00 09.07. 2:00

<




Animating a solar panel (1/2)

16. Adding a Subpart: Solar Panel (GS) e

DEB20|EEBY®IDC €cnes

1. Rightclick on “ " Satellite Universat” e
2. Click on the menu “Add Subpart” T 4 Cemeiine: o
3. Rename the new component “GS” T e R—
4. Select the CAD model: O —_—

1. Models/CIC Sat GS.3ds o o

2. Unit: mm P

3. Rotation center : X= 0,115; Y=0; Z=0 P i

5. Define the orientation axis as Y (button “Axis and
angle”)

File  Project Help

BEHI OO HE% DC Cene
Structure | Scenario Editor I Ewent Type Editor |
Element Mame Model
4 Project i -
© Time & Options Approlmate e | 1 Uit
4 Q) Celestial Bodies 3dsFile: Models/CIC_Sat_GS.3ds
> @ Body Earth
& ﬁ Satellites Light sensitive
4 ", Satellite UniverSat Use 3ds coordinates  Unit : ‘E]
Events
20 Properties Rotation center
AL o el ‘ Coordinates in satelite frame : X = 0,115 mo¥=0 e .
Position/Orientation
4 1% SubPart 5.
3D Properties
Position/Orientation

&P ¢
& B
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Animating a solar panel (2/2)

Edit a test file to define the rotation angle:
1. Select the tab “File”
2. Click on the “New file " button ... then “ Edit file _~
3. Write the necessary values to perform:
1. 1turnin 40 s in one direction
2. Stopping for 10 s
3. Then 1turnin 40 s in the opposite direction
Launch the visualization in order to observe the animation
Replace the test file by:
“Data/CIC-Sat. ROTATION_ANGLE_SA 1.txt”
Click on the “Save ! “ button to save the configuration.

File Project Help

SHIOREERYIDC Ccnes
Structwre | Scenario Editor | Event Type Editor |
Element Name ® xm=o
4 Project
¥
@ Time & Options =1
4 @ Celestial Bodies Zm= 0 W
@ Body Earth
4 F Satellites
4 ' Satellite Universat Chedfaion
A %) Quate ) Euler angles @ Axis and angle () Direction () Alttude and Azimuth
S ) Quaternion ) Euler angles @ Axisandangle () Direction ( e and Azimu
3D Properties
Position/Orientation Aoz
PR
¥W# SubPart s Constant | Fil | Stream
3D Properties
Position/Orientation @x-To
4 @ Applications
€ Celestia 20 - Celestia ¥i= i
B 2dwin #1 - 2dWin 72 [a
Angle
® Constant | © Fle | @ stream |
@ CICfle:  UniverSpace G5_Angle.tet ‘@ =

14 BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA

j UniverSpace_GS_Angle.txt - Bloc-notes

o L

Fichier Edition Format Affichage ?

CIC_MEM_VERS = 1.0

ORIGINATOR = VTS
META_START

USER_DEFINED_PROTOCOL = NONE
USER_DEFINED_CONTENT = ANGLE
USER_DEFINED_SIZE = 1
USER_DEFINED_TYPE = REAL
USER_DEFINED_UNIT = [deg]
TIME_SYSTEM = UTC

META_STOP
57578 0 0.

57578 10 80.
‘57578 20 180.
57578 30 -90.

57578 40 0.
57578 50 O.
57578 60 -90.
57578 70 -180.
57578 80 90.
57578 80 0.
57578 100 0.

COMMENT Generated by Spacebel €csps library
CREATION_DATE = 2016-03-15T07:55:44. 358941

Ccnes



Simulation of a RF emission (1/3)

17. Adding a sensor

Right click on “ "% Satellite Universat”
Select the menu “Add Sensor”

Rename the sensor “S_Band_Antenna”
Define an half angle of 60° on X and Y

Choose a color for the visualization

arwbdPE

18. Creating a ground station

Right click on “Body/ @ Ground stations”
Select the menu “Add Ground Station”
Rename the station “Kourou”

arwbdPE

Long. : -52,64 °; Lat.: 5,1° ; Alt. : 94m

15 BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA

Define the position and the target (satellite) :

BEOO BE% D Ccnes|
Structure | Seenario Editor | Event Type Editor |
Element Name Physical properties
4 Project
@ Time & Options e |Elplil =
4 @ Celestial Bodies ‘ HalfandeonX: 60,0001
> @ Body Earth
Half-angleon ¥ : 60,0001 (ceg. -]
G Satellites i -
W Satellite UniverSat Graphic properties
Events
2D Properties Range: 10000 fm
3D Properties Sensor volume
Position/Qrientati
4 9% SubPart Gs Color: (| Opacity: s0% [+
3D Properti

Sensor contol

,
Position/Orientation 1=
B © e cor:

Position/Orientati [C] Sensor swath
@ Applications
€ Celestia #0 - Celestia el =
B 2dwin #1 - 2dWin Opadity : [0

Color : |Orbit path color ~

File Project Help

ENSTHCECHEE: B 1k N~

Element

Structure | Scenario Editor | Event Type Editor |
4 Project
@ Time& Options

Mame ot
4 0 Celestial Bodies

4 @ Body Earth
2D Properties
3D Properties
Position/Orientation
4 @ Ground stations
; ‘GroundStation Kourou
2D Properties
Properties
ﬁ) Points of Interest 3
j‘j: Regicns of Interest
4 GF Satellites
4 " Satellite
Events
2D Properties
3D Properties
Position/Orientation

UniverSat

General properties
Station name :  Kourou
Geographical position
Latitude (deg): 5.1

‘onglmde (deg) : -52.64

Altitude (m) : 94

Antenna Target

@ Altitude (m) | 1000

© satelite ()] [Sol/Earth/Universat

©: PASO
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Simulation of a RF emission (2/3)

4% UniverSatuts (D:/Utili rochalp/Document: Vis-Wit T-32bits-2.7/Data/ExempleCIC) - Timeloop VTS 2.7 (= [ 12 |

DIOJHIER: B I8 X < Ccnes
19. Adding the states ot | St e | | | |
L LAR W W MmN ||na‘n7.1snn.nn .. 08.071606:00 . | 09.07.161200 ., 09.07.1618:00 ||
. . i 1 Scenario ] /“'Y T T T' N I
1. Select the “Scenario Editor” tab on your configurator 4G 5o FOTEN VIOV S
2. Add the file with the satellite modes ( -« Add files... ) : 4/ ATV 5 S
Data/CIC-Sat_ SATELLITE_ MODES_EN
3. Right click on the event “S_BAND_TRANSMISSION” ‘ L —— »
4. Selectthe menu “Create state at event”
5. Create a second state for the next event (STANDBY)
& UniverSatts* (DyUtilisateurs/rochalp/Documents/Software/Vis WindowsNT-32bits-2.7/Data/ExempleClC) - Timeloop VTS 27 (oo S
" ;Prg I-:.E‘p!. +EB% DC Ccnes
Structure | Scenario Editor | Event Type Editor |
N - . . - = AHEC DREORORC) P:DD . 09.07.16 05:00 . 09.07. 16 06:00 . DQ.q
20. Defining the visualization parameters for each state | Ty WV — T
. . o e on DN e=e————————
1. Click on first state on the Timeline 4 CICrSat_soTA'I'ION_ANGLE_SA_Lm 1 1 1

5 CIC-Sat_SATELLITE MODES bt & [ X =

2. Tick the case Sensor volume to make the sensor visible
3. Remove the Sensor volume for the second state

State Editor
/L bel : Date : Time Ratio :  1,00000
. Application Property name Value
#0 - Celestia [ false
[7] false
#1 - 2dWin
true
. . . . . [¥] true
When adding a state to the timeline, think about adding a label to fa.;e q
. . false £
better identify the event. = tabe B

&P ¢
& B
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Simulation of a RF emission (3/3)

IB =0 - Celestia [EENIEEN]| [ #0- Celestia Y

UniverSat_SunDir i : 2 Earth_Eme2000Axes
= (n] 1

@lniver ...

% UniverSatuts (D:/Utilisateurs/rochalp/Documents/Software/Vts-WindowsNT-32bits-2.7/Data/ExempleCIC) - Timeloop VTS 2.7

File Project Help

Sl ® G B %D C

Structure Scenario Editor Event Type Editor

L cnes

3 W /._. NG RO RORC 09.07.16 00:00 09.07.16 06:00 09,07.16 12:00 09.07.16 18:00
L~}
Scenario ' ' [ [ '
CIC-Sat_POSITION_VELOCITY.TXT — AN AN AN AN N N
CIC-Sat_QUATERNION. et h

CIC-Sat_ROTATION_AMGLE_SA_1.txt

CIC-Sat_SATELLITE_MODES.txt : x x x x x | |

[ I o WY N

F [ 4 m

BE CIC — Mise en ceuvre VTS-CIC — JL. Le Gal - DIA/PA :‘__ 5 PAS O



